
Contents: 

Why exhibit? 

Digital Nature 
FRPS Panel 

From my 
Travels 

Slippery 
when wet 

Picture Notes 

A cry from 
the 
wilderness 

The DIGIT 
listserver 

DIGIT 
June 1999 Issue 9 

•••••••••••••••• 

The Royal Photographic Society 
Digital Imaging Group 



DIGIT 

Over the last few years, I have sent 
my pictures off to exhibitions with a 
fervour that verges on eccentricity. 
Why? Because, I find it very stimu­
lating. 

Much of photography is a solitary 
thing - well, for me it is. Group 
outings may be fun and sociable, but 
I have never produced a good image 
as a result of such an event. Working 
on my own makes me use my grey 
matter a little harder and I do not feel 
inhibited by people round me staring 
and wondering what I am up to. 
There are exceptions, of course, such 
as the time I tried to photograph three 
nuns against a shop window full of 
exotic ladies underwear (the under­
wear was exotic - not the ladies). I 
eventually chickened out when a 
small group formed behind me, 
probably assuming that I was some 
sort of pervert. 

The feedback from good exhibitions 
is also a great stimulus. Catalogues 
from some foreign exhibitions are of 
an extraordinary quality and for an 
entry fee of about$ l O to $15 (they 
usually ask for dollars, although the 
French want francs!) you very often 
get an exhibition catalogue that 
would set you back two or three 
times that amount in a book shop - if 
it were available in a book shop. So 
this way you see images from 
photographers all over the world. The 
variety, originality and quality of 
many of these images is extremely 
high, but most exhibitions are trying 
to show a broad spectrum of work, so 
inevitably there will be some pictures 
that you do not like. 

The cost of sending your work 
abroad is not now prohibitive, 
especially in Europe. Most European 
exhibitions will quite happily accept 
unmounted prints, so if you send 16" 
x 12" or A3 prints in a sensible 
package, it will cost you little more 
than sending a box of slides. 

Of course, you need to be really well 
organised and dispatch your work in 
good time to beat the various postal 
systems through which it may have to 
pass, but to date, I have never had 
work delayed enough to miss the 
entry dates. So far, I have never lost a 
picture. They have all come back, 
although sometimes it can be quite a 
prolonged affair. Most entry forms 
will give you a calendar of events 
which includes the dates for the 
return of your work, but then you 
must add on the time in the post. 
Where do you find out about such 
exhibitions? There are a series of 
British exhibitions which have 
grouped together and information 
about them can be obtained from Don 
Brown, 60 Babingley Drive, Leices­
ter, LE4 OHJ by sending a 9"x6" 
S.A.E. 

Undoubtedly the easiest way to find 
out about international events is to 
contact the person in your local 
federation who is responsible for 
liaising with the PAGB. They will 
receive lists from FIAP at fairly 
regular intervals which give you 
much of the information you need, 
such as entry dates, type of work 
admissible and even a star rating for 
the quality of the exhibition cata­
logue! If you furnish such a contact 
with a supply of stamped addressed 
envelopes, they will pass on a copy 
of the list. If you are a member of 
Image Sans Frontier, their bulletin 
lists many of the international 
exhibitions available and one of their 
members even has a web site from 
which you can obtain entry forms! 

Some of the photographic magazines 
also give details of exhibitions (and if 
you are so inclined - competitions 
with prizes) and of course there are 
exhibitions for prints and slides 
organised by The Royal Photographic 
Society which are very well worth 
entering. The London Salon are 
pleased to accept prints for considera­
tion for their annual exhibition, 
which is perhaps one of the more 
interesting events in this country. 
So you send off your work and 
usually it gets rejected! 
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There is a learning curve! Exhibition 
photography is not the same as club 
and federation photography. The 
standard is somewhat higher, but this 
is surely all part of it! Why enter the 
easy ones? Getting your first accept­
ance in an international event is a 
great thrill and when you gain awards 
and medals you know that you have 
achieved a reasonable standard of 
work. 

Digital work is now widely accepted 
in exhibitions, although a few 
unfortunate souls have decided to 
segregate it into specialised classes. 
To me, this is an unfortunate attitude, 
I have long held the belief that 
competition and exhibition should be 
open and that any form of segregation 
is to be regretted. A picture is a 
picture! Fortunately there are still 
some open exhibitions - the afore 
mentioned London Salon being a 
classic example. A thick skin and a 
philosophical outlook are essential to 
the frequent exhibitor - the picture 
that earned you an award in exhibi­
tion 'A' may not even get accepted in 
exhibition ' B', but if you have chosen 
your exhibitions with care, you will 
see what sort of images beat yours 
when the catalogue eventually drops 
through the letterbox! 

Occasionally, the organisers will 
write to ask if they can keep your 
work. (There seems to be a much 
greater value attached to photo­
graphic images abroad, than at home, 
especially in Spain). I usually agree 
to these requests - I suppose it is a bit 
flattering to think that they want your 
pictures for ever (?) but surely the 
main purpose of producing pictures is 
for them to be seen by others and for 
most of us the best way of achieving 
this is to have our work exhibited to 
as many people as possible. It is only 
by letting your work be seen by other 
people that you have the opportunity 
to communicate through your 
pictures - what other purpose really 
matters? 

JobnW.1'blt: 
FRPS MPAGB AFIAP 



It is only by letting 
your work be seen 

John Gray ARPS by other people that 

David Taylor ARPS 

There are a series of British exhibitions 
which have grouped together and 
information about them can be ob­
tained from Don Brown, 60 Babingley 
Drive, Leicester, LE4 OHJ by sending a 
9"x6" S.A.E. - John West 

John WestFRPS 
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you have 
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through 
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other pur­
pose really 
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Having been successful in gaining 
APRS in the Nature category during 
the Spring of 1998 with a Panel of 15 
slides of undeiwater subjects, my 
thoughts turned to the next big 
milestone- Fellowship! Attendance at 
an excellent Advisory Workshop at 
Juniper Hall confumed my hunch that 
making the transition to prints would 
give me much more opportunity to 
make the most of some of my existing 
material, in particular by cropping to 
improve composition. 

Inspired by Paul Kay's success with a 
digitally printed panel and given the 
fact that I have no access to a dark­
room, I decided to investigate the 
feasibility of producing a print panel at 
home. At this stage, I didn't even know 
whether the 'consumer market' 
equipment that I would be able to 
afford would be able to produce a 
good enough finished print! My next 
step was to attend a four day DI 
workshop at Duckspool which gave 
me a whistle-stop tour of Photoshop 
and a shopping list comprising an 
Epson Stylus 1520, a Minolta Dimage 
Scanner, plus Zip Drive, SCSI card and 
miles of cabling to connect it all to my 
Gateway PC. I also bought 
Photoshop4 bundled with PageMaker 
and other Adobe software. 

I'm pretty much a beginner with 
computer technology, so it took me 
several weekends to get eve1ything 
connected and working and to get a 
basic grasp of Photoshop, but I was 
very excited with the first few prints 
that I made. It was clear that I was 
going to be able to achieve very high 
definition and surprisingly faithful 
colour reproduction, so I committed 
myself to prints for what I believed 
would be my first of possibly several 
attempts at FRPS. It was now Septem­
ber and I also set myself a target of 
submission for the March'99 assess­
ment, for no better reason than that 
for me, deadlines concentrate the mind 
wonderfully. · 

I selected nearly 40 images to work 
with, some of which I had already had 
commercially scanned onto PhotoCD 
for archiving purposes and some of 
which I scanned at home. I made 
rough prints of each one and whittled 
the list down to about 30, which I 
started to work on seriously. Some 
images required virtually no work at 
all, beyond cropping and printing. A 
number benefited from adjustments to 
brightness and contrast. In some cases, 
'Autolevels' produced a perfect result, 
whereas in others it created rather 
bizarre effects and I made the adjust­
ments manually, so to speak. About a 
quarter of the images suffered from 
minor 'back scatter' caused by the 
reflection of flash lighting from tiny 
particles suspended in the water- the 
bane of underwater photographers. I 
used the clone tool to eliminate these 
blemishes. However, I was scrupulous 
not do anything which would funda­
mentally change the original image of 
a creature pictured in its natural 
habitat. 

When I was satisfied with each image I 
set about producing full size prints 
25x3 1 cm, using A3 sized Epson 
Photo quality Glossy Paper. My PC 
only has 56MB RAM and so to avoid 
making the print ftles too big to 
manipulate reliably, I limited the print 
resolution to 300dpi, giving print ftles 
of about 25 Mb, which I found wholly 
adequate for good quality results. I 
used the printer on its automatic 
settings and 360 dpi print quality. 

However, I was not out of the woods! 
My first attempt at mounting the prints 
was disastrous. Since the printing paper 
was rather thin, I spray-mounted them 
onto mounting board, then finished 
off with a window mount. However, 
within 48 hours, almost every single 
print was peeling off the backing 
board and was ruined! I'd like to say a 
very warm thank you to all those 
members of the DI Group who 
responded to my rather desperate e­
mail plea for help on what might have 
gone wrong and suggestions on how 
to mount digital prints successfully. 

I received a magnificent 15 replies via 
phone and e-mail, with an interesting 
range of views. 5 recommended 3M 
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Photomount, while a further 3 said 
they never used spray mount at all 
because of the risk of damage to the 
print. 3 use dry-mounting tissue and 2 
use self-adhesive board, while one 
gentleman (a man after my own head) 
said he'd found a professional willing 
to do the hard work for him! 

In the end, I reprinted my entire my 
panel on heavier Epson Photopaper 
and followed Barrie Thomas' helpful 
guidance to simply stick the print onto 
the back of the window mount with 
masking tape, working on a light-table 
to be able to see what I was doing. 
This seemed the simplest method of 
all and in the end produced a very 
satisfactory result. 

Then, with 30 prints successfully 
mounted came the hardest part of all, 
to make a final selection and put 
together a panel of prints that I felt 
would not only meet the standard 
individually, but that would work 
together as a whole. Here, I was on my 
own and Photoshop could do nothing 
to help! 

Finally, I followed John Tyler's excel­
lent article on how to make a contact 
sheet to show the hanging plan and 
after some last minute dramas when 
Parcel Force failed to deliver a transit 
case I had ordered, I managed to 
deliver my panel to Bath on the last 
possible day for the March assessment. 

It goes without saying that I was more 
than delighted to be successful and 
attain FRPS at my first attempt. I have 
cettainly enormously enjoyed the 
experience of learning digital printing, 
though I have no intention whatever 
of changing out my trusty Nikon 
35mm cameras and beloved Fuji films. 
For me, digital processing and printing 
of images is simply an accessible and 
satisfying alternative to the 
Cibachrome prints that I used to have 
to rely on someone else to produce for 
me. 



Coral Reef 
Pictures 

Spinecheeked 
Anemonefish 

This picture was taken in Papua ew 
Guinea, on Velvia film, using a 
Nikonos RS camera with 50mm 
macro lens, and illuminated by two 
SB103 flashguns, on m control. 

l11e 01iginal landscape format has 
been cropped, some minor blemishes 
touched out using the clone tool, and 
Autolevels applied. 

These fish spend their lives amongst 
the poisonous tentacles of their 
d1osen host anemone, co which they 
have become inlmune. 

ColonialAnemone 

l11is picture too was taken on Velvia 
film, this tinle using a Nikon F90X 
camera and 105 mm macro lens, 
enclosed in a Subal underwater 
housing. Again, I used two SB103 
flashguns on TfL contro l. 

The digital treatment was much the 
same as above. I was very pleased 
with how well the black background 
p1intedup. 

l11is tiny anemone with ics be'.autiful 
pattem was living high up under the 
roof of an unde1water cave. 

Anne Owen FRPS 

(see the colour page 1) 

A Cry 
from the WIiderness 

I live at the perimiter of photographic 
knowledge, in Eaglescliffe, where the 
cliffe has gone, probably been looted 
by marauding southerners, and the last 
eagle was shot down ye-ars ago 

Explorers have been known co 
penetrate chis far and, if one proceeds 
carefully, plaques can be seen record­
ing 'Banie the l11omas was here'. 
Standing quietly, shoals of mini-digims 
can be seen seardling around for bics 
of infonnation on digimiting 

Many months ago that ve1y 
contageous digim d isease struck me 
resulting in nauseating frustration and 
sclerosis of the bank account. This has 
been traced to a Canier, ... the afore­
mentioned B.Thomas, w ho has much 
to answer for. 

l11en came an attempt at salvation, for 
in a neighbowing settlement called 
Middlesbrough, a Leader of Quality 
arose, Btian of the Gilbe1t T1ibe, and 
he led six or so snlitten and struggling 
digims out of the wilderness. As the 
word spread tl1ere came a totTent of 
seekers and soon the roll call reached 
over tllirty and it is 1ising as I wtite 

By now strange happenings were 
beginning to take shape and in that 
Holy of Holies, BATH, where, in spite 
of mutterings of disaster and dissent, 
tl1ere came about a special major ttibe 
or group entirely devoted co succour­
ing tl1e well being of dig ims. It is 
suspected tl1at the conscience of that 
B.T (no you fool not telephones) 
nlight have sec it rolling but there came 
a beautiful sctibe called Glenys, a 
writer of tablets William of Henley, 
and spreader of the word John the 
long one, and there were others. 

So much complicated instructions 
were issued, even tl1e great Pollock 
cook a hand and so d id Him of me 
Medics. Alas the words were many and 
complex, the prophets excelled 
themselves producing reams and reams 

~loa-a!!!I of complic.aced measures on how to 
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do the same thing many many ways. 
Confusio n reigned in the little grey 
cells of many of the digims. But they 
persevered and some success was 
shown, but there were residual troubles 
to be fought 

A strange visual phenomenon was 
sought called wysiwyg w hich made 
what the fading eyes saw on a screen 
repeated on tablets. So many were 
disappointed because it did not happen 
and sabotage was suspected. Had those 
penetrating Southerners nlisled the 
simple ones? And tl1is was fu1ther 
made ill by the substitution of d iffer­
ent kinds of tablets in the sctibing 
machine and all gave out diffe1ing 
results. There arose much discontent 
and wailing for some tablets had a 
beautiful gloss, were costly, but 
emerged from the womb of the 
SCJibing machine bearing different 
colours as though their forbears were 
not exactly what they had seemed. oc 
only that but when attempcs were 
made co adhere those glossy results to 
mounting tablets tl1ey suffered baclly 
from bubblitis and, although they were 
dead, tl1ey would not lie down and 
problems proliferated. 

Then, o ne b1illiant day, the water of 
despair sank a little and out of the 
Internet came a dove canying mes­
sages of hope from a country many 
thousands of miles away. It bore 
messages celling of protective sprays 
enabling the 01iginal tablecs co be used, 
it cold of many experiments with many 
different makes and kinds of tablets. 
Then those frustrated tiny diginls 
began to wonder if the prophets in 
their own land would seek out these 
altematives, spread around the infor­
mation and sources, and enable those 
fu1ther complic.ated wtitings co 
fulnlinate into glo1ious presentations. 

Hope springs eternal, so let us spray 
for assistance. 

Ray Wallace Thompson 
ARPS FPSA AIIPC 
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With so many 'filters' now available for 
image processing software, such as 
PHOTOSHOP, it may be timely to 
remind ourselves of the creative 
possibilities that can be perfo1med 
without recourse to complex math­
ematics. The ~ic eight operatio ns in 
PHOTOSHOP , when thoroughly 
mastered, can provide a very powerful 
tool-set upon which to expand as and 
when the need arises. 

The initial inspiration for the image 
came from the modernistic apartments 
in Rotterdam, Netherlands. At first 
sight (Fig 1) they look just like 'cubes' 
perched precariously on cona-ete piles 
- and this is precisely what they are. 
Futuristic, certainly - but how do the 
carpets fit? A surreal image forged in 
the real world. Just my sort of thing. 
With so many straight edges the 
selection to extract the required 
elements from the background, was 
relatively easy (Fig 2). Control of 
wntrast was followed by the enhance­
ment of the colours (by 'Variations') 
until the desired effect was achieved. 
By use of the 'mirror copy' Fig 3 was 
achieved. These elements were 
positioned and sized before the sky 
was added to allow total control of the 
composition. 

Foreground element started life as a 
shot of water droplets on the bonnet 
of may car (Fig 4). Yes, the car was 
recently cleaned but only for photo­
graphic purposes to get the regularly 
spaced mini-pools of water. The image 
was mirror copied to give a doubled 
image which neatly fits together, 
slightly twisted (sorry a filter used here! 
- but not absolutely essential). The 
dramatic colour comes from experi­
mentation with tl1e contrast control 
and the 'Curves' facilities. Fig 5 shows 
an intermediate stage before final 
colouring. A correction for perspective 
can be performed easily. The central 
'church' (Fig 6), although initially very 
symmetrical, was used to link the 
architectural elements together with a 
slight 'Chesterfield' tw'ist. 

In my pre-digital period I used 
patterned glass extensively. Here a shot 
of a summer sky taken ilirough the 
glazed front-door as been adjusted to 
yield a very dr'amatic sky (Fig 7) and 
slotted onto a layer behind the build­
ings. 

The costumed swimmer was shoe in a 
studio in a variety of poses to simulat­
ing back and front strokes. Experimen­
tation showed that a fully nude study 
did not work as strongly in this 
particular image. 

A well positioned 'banana skin' give an 
implied sense of the 'comic' to the 
image as we all have been brought up 
to know what is meant to happen in 
such circumstances! Is real life tl1is 
predictable? 
Finally tl1e shadows are added co 
complete tl1e image ... 
SLIPPERY WHEN WET. 

MyTop8. 
'selection', 'cloning', control of 
brightness, contrast and colour. 
Resizing and perspective. 
Basic layer control. 

Formoreintbis series see 
DIGITAL PHOTO ART. 

johnlaw 
FRPS MFIAP 

(scemlourpage9) 

Notes on 
Two Pictures 

Plate of Fruit: 

This started life as a B & W neg. on 
TMAX which I scanned in as an RGB 
image. I created a new background 
copy layer and treated it to the Dry 
Bntsh filter at settings to suite the 
image.The original background layer 
was then deleted. I then painstakingly 
"hand" coloured the fntit with a soft 
edged bnish used in color mode in 
order to preserve the grey tones, 
varying the opacity settings as 
required but leaving the silver plate 
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unwloured as grey. I carefully selected 
all the fniit and plate, excluding the 
shadow, with the pen tool and con­
verted the path to a selection - I could 
equally have used the polygon lasso 
tool - and saved this selection as a new 
channel mask.On a new layer, I then 
drew a large selection with the mar­
quee tool heavily feathered (about 60 
pixels) as a background area, filled it 
with a suitable pastel colour and added 
the saved fruit selection as a layer 
mask. I followed a sin1ilar procedure to 
create a third layer containing the 
saved selection, feathered and filled 
with a suitable grey to form the 
shadow, nudged slightly left and down, 
which I dragged below the b-ackground 
copy layer. (see colour page 7) 

Swaynes Mead: 

My objective with this image was to 
create a painted water-colour effect 
and to help newcomers to Photoshop 
(Version 4 in my case) I w ill try to 
explain how I achieved the final 
result. 

I scanned in a colour neg. of the 
cottage, and firstly cleaned 
up the picture by cloning out road 
markings and TV aerials etc. with the 
mbber stamp tool. The original sky 
was rather bland, so I selected the sky 
area with the magic wand (tolerance 
set to 15), adding further sky areas as 
necessary by shift-clicking the magic 
wand until tl1e whole of the sky 
appeared to be selected. With quick 
mask turned on and foreground and 
background colours set to default, I 
paid particular attention to the edges 
of the selection around the roof and 
the tree and with a small bmsh 
painted out any stray sky p ixels 
remaining unselected which n1ight 
later leave a wl1ite or grey edge 
around the unselected area. I saved 
the image at 
this point. 

An alternative to this quick mask 
method, I could have expanded the 
selection by one or two pixels -
Select>Modify>Expand. Once 
satisfied with the selection which I 
did not deselect, I opened another 
image of a more interesting sky, 
selected the area I wanted and copied 



David Taylor ARPS 
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Cyclist 



it to the clipboard.(Edit>Copy or 
Ctl+C). This second image was then 
closed and back in the original image I 
used Edit>Pastelnto to insert the new 
sky which appeared on a new layer and 
which, with the move tool, can be 
moved around to suit. Once I was 
happy with the new sky, there was no 
longer any need for this separate layer 
so I flattened the image (Layer>Flatten 
Image) to keep the file size down and 
saved again. 

To create the water-colour effect, I 
duplicated the Background layer by 
dragging its layer tile to the new layer 
icon at the foot of the layers palette 
and then subjected the Background 
Copy layer to the Dry Brush filter with 
settings chosen to suit the image. With 
the copy layer still active, I chose 
Luminosity mode from the drop-down 
list and reduced the opacity a little to 
achieve the effect required. Alterna­
tively, I could have applied the filter to 
the background layer itself and used 
Filter>Fade immediately afterwards 
but this is iITeversible once any further 
work is done. Using the copy layer 
method, one's options to change 
remain open! 

To add tl1e border, I increased the 
canvas size by about_" all 
round, used the marquee tool to 
include the whole image area plus 
about half the new border and then 
chose Select>Modify>Border to create 
a feathered selection x pixels wide ('x' 
depending on image resolution).Tois I 
then filled with a foreground colour 
chosen from the image - grey in this 
case - using tl1e eye dropper tool to 
click on the colour and then 
Edit>Fill>Foreground Colour or Alt 
+ Backspace. Before a final save, I 
printed the file with the Epson 
PhotoEX onto cartridge paper to 
enhance the water colour effect; only 
when I was satisfied witl1 the end 
result did I flatten the fi.le and save it.. 

(see page3) 

Frommylravell 

Fire 
This picture came from a colour slide 
taken at the Pushkar Camel Fair in 
India. Toe original slide was rather 
dark, so after scanning it mto 
Photoshop I opened the Layers 
palette, copied the background to a 
new layer and blended this layer with 
the background using Screen blend 
mode to produce a lighter result. I 
then applied tl1e Photoshop Dry Brush 
filter, followed with Lightmg Effects 
and Texturiser. 

Sonl..a 
I started with a colour slide of the 
cyclist on a dusty road in a small town 
called Son La in Vietnam. After 
scannmg the slide I first used the 
Rubber Stamp tool iI1 Photoshop to 
remove some highlights and an 
unwanted figure in the distance which 
clashed with the cyclist. Toe mother 
and cl1ild were then imported as a 
layer from another slide taken a few 
minutes earlier. I then had to produce 
the shadow of the mother and child to 
match tl1e shadow of tl1e cyclist. To 
do this I copied the layer, flipped it 
vertically, filled it witl1 colour sampled 
from the cyclist shadow, used Layer­
Transform-Distort to produce a 
suitable shape and finally blended the 
shadow layer with tl1e road surface 
usmg Multiply blend mode. 

Bridge 
Toe original slide of a farmer crossing 
a suspension bridge in Vietnam was 
taken in low light and was not a 
success, but I was attracted by tl1e 
mteresting outline so I scanned tl1e 
slide into my computer to have a play. 
I copied the background to Layer 1 
which was tl1en desaturated and red 
and yellow were added. Layer 2 
comprised an image of a misty sunrise 
taken iI1 Spam and for Layer 3 I copied 
tl1e background again and applied 
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Highpass followed by Equalise. To 
achieve the fmal result I turned off the 
background layer and tl1en blended 
Layer 3 using Overlay and Layer 2 witl1 
Multiply blend mode. 

Cyclist 
For this photograph of a passmg 
cyclist taken on a recent holiday to 
Vietnam I panned tl1e camera using a 
slow shutter speed to blur ilie back­
ground. After scanning tl1e slide into 
Photoshop I increased tl1e blur slightly 
usmg tl1e Gaussian Blur filter with a 
low radius value and I removed one or 
two distractions from tl1e background 
witl1 tl1e Rubber Stamp tool. 

Devotions 
Toe original photograph was taken 
from a boat in tl1e early morning at 
Varanasi in India. After scanning ilie 
slide into Photoshop I opened the 
Layers palette and copied tl1e back­
ground to a new layer. This layer was 
then subject to Add 'oise, Color 
Balance to wann tl1e image up a bit 
and tl1en to the Poscerised Edges filter 
before blending witl1 the original 
background usmg tl1e Luminosity 
blend mode. 

Monk Darjeeling 
Toe colour slide of the monk at a 
monastery was scanned into 
Photoshop in my computer using a 
Nikon Coolscan. Toe background 
beyond tl1e door was over 
exposed witl1 no detail and tl1e backlit 
smoke/flowers came from another 
slide taken at tl1e same location. After 
some small adjustments iI1 Ph0toshop 
the picture was opened in Pamter ( this 
is Pamter 3 which has been given away 
free recently witl1 Macworld August 
1998). I ilien used the Auto Van Gogh 
variant with the AutoClone command 
to achieve tl1e effect. 

TomBoweUFBPS 

Point your browser at: http://www.dlgtt.oq.uk 
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Re: Printing papers 
Posted by Ruth Rittichier on Friday, 
19 Februacy 1999, at 11:11 p.m., in 
response to Re. Printing papers 
posted by Russell Rohde on 
Wednesday, 10February1999, at 
6.s4p.m. 

Tiy "Kodak Inkjet Photographic 
Quality Paper (Photo Weight)'. I 
noticed on my newest pack they have 
changed the name to "Kodak Inkjet 
Photo Paper(l17 lb. paper)". I prefer 
this over all the others you have 
mentioned. Although I have an Epson 
Stylus 600 printer, the Epson Glossy 
paper does not look as good to me as 
the Kodak paper. As you have noticed, 
the Epson paper prints too dark. I 
have entered Kodak Inkjet prints in 
the camera club Commercial Colour 
Print competition (it's permined), and 
no one knew they were digital till I told 
them. 

Original email: 

I know sprays, lacquers, varnish 
coatings can give "glossy" spruced-up 
look to digital prints but I believe 
speciality papers is a better route. 
Generally I would reserve sprays, etc. 
to preserve colour, etc. for archival 
purposes to prevent fading, etc. 

My personal experience with a goodly 
number of glossy 
papers is that it is hard to beat the 
Epson line of printing media: there are 
about 6 grades to choose from and I 
would limit choices to the bener three 
which are all PHOTO QUALITY. (a) 
PQ I] paper (b) PQ Glossy Paper (c) 
PQ Glossy Film (all Epson). 

As you noted, the "gloss paper results 
are usually ' veiy deeper in shade" and 
this is really a plus and in my experi­
ence typical of brands other than 
Epson as well. If the shades are too 
much, then PS can cut contrast, and 
often I have done this using about 5-
8% decrease contrast when the colours 
"jump out" too much. I found the 
saturation sometimes was because I 

switched from 720 dpi on PQ paper to 
1440 dpi on Glossy pa per and film. I 
cringe to hear the term "Epson InkJet 
stuff" 

I have recently tried "Great White" a 
glossy coated paper which reports to 
let inks sit up on the paper for more 
vibrancy. It is made from 25% recycled 
fibres. I have also recently used 
"Champion" InkJet High-Gloss finish 
(premium glossy co-ated paper) which 
is extra-heavy weight. Here the inks 
"dries on top" with precision and 
colours have added depth and bril­
liance. I find them comparable but not 
improved over Epson types described 
above. Prices are rather comparable for 
the similar types but a small premium 
added to the bener known brands. I 
think the brand and quality of the 
printer has a lot to do with the print 
quality. I do not recommend using 
refilled cartridges. I find that outdated 
inks are a real disaster and that freshly 
dated inks are essential. Perhaps share 
your printer model and choice of ink 
with us. I also think some plinters do 
best with certain papers and inks and 
that testing has to be done. I have 4 
printers but I prefer to use Epson 
Stylus Colour 800 for most work. 
When I first started plintings I used 
Canon p-apers but gave up. My best 
work is with dye-sub but that is 
another sto1y and not what this 
discussion conoems. 

submitted to DIGD' by: 

Raywallace'lbompson 
ARPS FPSA AIIPC 

In Issue 8 of DIGIT, Mr. 
Bowman writes about the 
Epson printers ~ion 
group and also about the archival 
inks for his printer, but gives no 
details, phone, fax, email, addresses for 
either, so the rest of us can not get 
involved. May I ask you to provide 
contact details. 

(edward@bowman.u-net.com) 
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I do agree with him about the lack of 
output. I read in the photo press that 
D I is either panned for being "naff'' as 
the manipulation is visible, "awful" as 
it is che-ating, and so on and so forth. 
Perhaps an exhibition that is "way out" 
and beautiful is needed, with all entries 
being as Jim Marsdens or Bariy 
Colquhouns. I must admit that I tiy to 
makeall manipulations I do invisible, 
such is my work, but it would be fun to 
go mad, knowing I had a chance of 
being exhibited. 

Jackie Major I.RPS LBIPP 

It was with interest that I 
read the comments expressed 
by Edward Bowman in issue 
8 of DIGIT, regarding the 
role and future of the DI 
Group. As a veiy new member to 
DIG my major reason for joining the 
Group was tl1e opportunity to view 
collections of images created by · 
people who have come to DI, like 
myself, via conventional photography. 
A practice akin to attending photo­
graphic Salons. Secondly, to hopefully 
learn more on how to manipulate 
images to achieve ones own personal 
goals. living where I am makes this 
last reason difficult unless some input 
appears in DIGIT. So what can 
DIGIT do? 

I have noticed that most of the 
members use Adobe Photoshop to 
manipulate their images. The User 
Manual that comes witl1 the program 
tells you what the Photoshop will do 
but most people get more benefit from 
public-&tions that explain how to use it. 
The Deke McClelland Photoshop 
book is a perfect example of this latter 
publication. A reader can view an 
image and ask themselves 'how did he 
do that?' and there in the book is die 
step by step process. You are then able 
to get one of your own images and see 
what it looks like with this treatment. 
For those who have upgraded to 
Photoshop 5 tl1ey now have the 
history palette. 

For DI members who are happy to 
desc1ibe to others the steps in their 



images they could copy the steps I must congratulate BalTie 
before 'saving' and have them pub- Thomas on his article in the 
lished in an "How Was it Done" 
column along with the image. Person- January edition of DIGIT, 

with which I heartily. and ally I would like to know the steps 
used by John Colmer with his 'clown'. totally agree. I'm afraid therefore 
This information together with tips that I have to disagree with Sir George 
like Barry Colquhoun's Lacquer & Pollock's reply, in particular his final 
Print Guard after treatment, and comment:" ...... it is an error to claim 
Edward Bowman's mention of archival that a photograph remains "pure" even 
inks ( unfortunately with no speci.ftcs) after it has been manipulated by non-
help people who can't attend meetings, photographic means ....... " 
exhibitions and workshops to gain the 
most from distant membership and 
expand their understanding of the 
medium. I believe that most of us are 
predominantly right-brained people. 
Images are what we thrive on. In the 
three copies of DIGIT I have so far 
received I am delighted in the quantity 
of visual material and I feel that if 
there were a few more accompanying 
explanations you will have captured a 
member for life. 

I have had a problem with 
opening files in 'raw' fonnin 
Photoshop 5.0 and although I 
followed the procedures 
outlined by Adobe all I could 
get was a thumbnail size file. 

Consider the following (tongue in 
cheek) hypothesis. 

Photogr-,iphy means drawing with light. 
That is, as Sir George quotes himself, 
" ... an image made by .... "light" ... .". Note 
the emphasis on the words "image 
made". 

Therefore "pure photography", it 
could be argued, is limited to the 
exposure of sensitised material which 
creates the initial image. All other 
processes whether chemical or 
electronic are, in the strictest sense, 
non-photographic. Enlargement may 
use pure photography but generally it 
is simply a means of transferring an 
existing image to another medium. The 
statement that" .... any manipulation 
that uses light is photographic in 
nature .. ..... " does not stand up because 
dodging, burning and second expo­
sures only modify the latent image and 
are therefore not photography in its 
truest sense ie. they do not create, they 
only adjust the density or tonal range 
of what has already been created. In 

I have however now solved the any event there are many chemical 
problem. These images came from a processes which manipulate an image 
Canon PowerShot Pro 70 camera and but do not involve light - eg toning, 
were on a compact flash discs. When I bleaching, intensifying, Colo1vir. 

tried to bring the images into 
Photoshop via a card reader I got the 
results described above. 

I now find the answer is that I have to 
install the Twain Driver supplied with 
the camera and transfer the images via 
a serial cable from the camera to the 
PC. - a very slow and boring proce­
dure - but the images are of excellent 
quality and worth the wait. 

But why, oh why does it matter?! If 
digital photography had been discov­
ered before chemical photography, 
would we now be arguing that chemi­
cal photography was not "pure" 
photography? 

To quote Barrie Thomas: "Why don't 
we behave as we always have and 
simply view tl1e finished image and 
make our own assessment of its 
artistic merit regardless of origin?" We 
do not need P+ categories in exhibi­
tions. 
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I am also interested in filming and in 
this discipline we have had many 
fundamental changes - from film to 
analogue video, and now digital video. 
The trend in post production work is 
clearly towards non-linear editing on 
computers, which includes manipula­
tion. All these cl1anges seem to have 
been welcomed with very little con­
cern, even with open arms. And in the 
professional film world digital manipu­
lation certainly does not preclude films 
from being considered for awards eg. 
"Titanic". 

On another topic- the pur­
pose of the Digital Group. 

I agree that digital photographs should 
be accepted in all other groups and so 
the Digital Group has no real purpose 
from an e nd product point of view. 
The groups main purpose, in my view, 
therefore, is to concentrate on those 
areas that are of Little interest to non­
digital photographers. 1hat is, keeping 
group members aware of, and review­
ing, new hardware, software and 
associated techniques plus general 
interest accounts of members experi­
ences in the digital arena. That is not 
to say mat I'm not interested in seeing 
examples of members work, I am, but 
I don't believe mat is me primary 
purpose of the Group. 

Test Strip -Photoshop Plug-in 

After reading HemantJariwala's article 
I downloaded me demo version of this 
plug-in but it doesn't do anyt11.ing 
Photoshop can't do, in fact Image/ 
Adjust/Variations is ve1y similar, and it 
is ramer expensive at $149 (about £90) 
or $129 if downloaded (£78). 
Photoshop itself costs about £200 
(Photoshop LE upgraded to 5.0, LE 
usually comes wim a scanner), this 
plug-in therefore costs 39% to 45% of 
the original outlay and I'm not sure it 
justifies that. I have purchased several 
useful programs, for audio and video, 
from internet sources mat cost around 
£25 to £30 which are probably more 
complex than Test Strip .. 



DIGIT 
Membership of two groups 
sometimes brings surprising 
results. In DIGIT of the 
Digital Imaging Group an 
article by Sir George Pollock 
really made me think 

In the last edition of Digit, 
there was mention of the 
eopyrighton photographs 
and I give below my experience of 
anomer copyright problem, this time 
wim digital cameras and which may 
give members' food for mought. 

I have written to Olympus asking for 
an authoritative response to confirm 
what is, after all, just comments from a 
salesman in a shop. 

His leading question 'What bothers 
people about DI is not that it is 
manipulation, but that it is manipula­
tion by non-photographic means'. and 
this leads me to consider the ethics of 
making an audio/visual using entirerly 
copies of photographs, sketches or 
cartoons made by anotl1er person, be 
mey ancient or modem. 

At Jessops Photographic Show in 
March 1998, at the NEC, 1 purchased 
an Olympus 1400L Digital Camern 
wim which, I must say, I am delighted. 

The new 
DIGIT llstserver 

Of course mere are often times when, 
to complete a study, one needs to copy 
someming as a running part of a 
presentation, but to base it entirely on 
copies seems to me to be cheating. Of 
course this doesn't prevent one 
enjoying me result and I can recall 
some very funny cameos which I could 
see again wim pleasure. 

It is difficult to accept that the entire 
audio/ visual is 'own work' when me 
skills of someone else is virtually me 
main base omer man the fact mat me 
A/V worker photographed (pinched) 
it. arurally sometimes me copies are 
arranged wim me artist or publisher, 
and sometimes done by joint effort; 
frequently acknowledgements are 
given, but 'Own Work' still d~ n?t. 
seem to apply unless an entry 1s a JO!Ot 
one and an award, if appropriate, is 
given on mat base. 

My nearest Jessops involves approxi­
mately a 35-mite round trip and as it 1 
situated in me middle of Oxford, I 
rarely am able to get tl1ere. However, a 
short while ago, I managed to fit a visit 
in and after completing my purchases 
asked mem what it would cost me to 
upgrade my camera to d1e latest 
version. I was quoted meir standard 
price for me new camera but was 
surprised to learn mat mey were 
unable to take my existing camera in 
part exchange. 111e salesman was very 
apologetic, saying mat me Company 
would like to be able to take in used 
digital cameras but was unable to, not 
because of the camera or its type, but 
because of me software. 

What is a listserver? 

I was cold that when I oought and used 
d1e camera, the software became 
licensed to me and as such w-.:1s not 
transferable at the present time and 
until this problem was resolved d1e 
position could not change. When I 
asked what people did wid1 their 
cameras, I was told that most people 
threw or gave d1em away. 

It is an easy way for members to raise 
issues and to publish information. 
Once a subscriber to the list a member 
will receive a copy of each and eve1y 
email sent to the listserver. Whats 
more any email mey send to me 
listerver will be automatically sent to 
all other subscribers. 

If at any time there is a wish to leave 
then just send an unsubscribe email. 
The system is self regulating. Too 
many irrelevant or irritating emails and 
there will be no subscribers! Used 
properly it Ls a very efficient way to 
talk wid1 me group. Together with the 
DIGIT web pages me listserver 
provides an effective communication 
system to complement DIGIT and the 
meeting<,. 

See the back page for subscription 
details. The subscription confumation 
email gives further instructions on how 
to use the system. 

Recently I was graded second place in 
a local competition by a photograph 
taken some years ago at me same time 
as I was shooting the same scene. I was 
taking a stereo shot and was using the 
'paint with light' flash system. Un­
known to me anomer chap was behind 
me using my work and taking the same 
picture, this was the winner. Actually it 
didn't oother one much, at my age I 
couldn't care less BlJf .... makes one 
think. I wonder if A/V members have 
given much thought to this? Perhaps 
Sir George might give us his com-

r don't know the reason for this, but I 
suspect that somewhere, someone feels 
that they can receive additional funding 
for products already sold. I am not too 
concerned aoout this at the moment as 
I suspect the price tl1at would have 
been offered would not have per­
suaded me to change. However the 
point remains that most purchasers are 
not aware of the position, which if it is 
correct, means mat once they buy a 
camera, it cannot officially be sold with 
me software, which I understood to be 
all the software. That which is neces­
sary to work the camel"a as well as the 
bundled third patty progr-Mf!S. The 
latter, J can understand, but I find the 
fonner unacceptable. 

In addition to the DIGIT list there is a 
FOLIO list and an RPS list. The first 
is a new way to send your images to 
others for comment. The second is 
intended as a list for all RPS members. 
Substitute FOLIO or RPS for DIGIT 
in the subscribe message. 

This is an experiment to assess the 
value and effectiveness of the system. 
Please give it a whirl and let us know 
what you think. 

ments .. 

--· ,:'dlmnploa _,.l'PSAAIIPC 
BUlBenleyUIPS 
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Creating a Dlgltal Panel 
In Photoshop 

MENU 

>New 
>Preferences 
>Define Pattern 

>Help 
>Import 
>Transform 
>Arrange 
>Adjustment Options 

>Print 
>Export 
>Fill 

>Preview 
>Can't Undo 
>Cut 
>Gamut Warning 

>NewView 

ACTION 

Associate of the Royal Photographic Society. 
to pass first time! 
a few ideas floating around in my he-ad 

- enough for a panel, I hope. 
Distinction Workshop - I don't need that! 
plenty of images to manipulate . 
images into a collection of Digital Art. 

into a well presented panel. 
ask a few family and friends 
- change it all around. 

the final panel. 
to the RPS in Bath. 
The Octagon with locs of ARPS's, FRPS's 
and wanna be's! 
my panel! 
too late now. 
they hated it - I failed. 
sadness, disappointment, annoyance, 
frustration, determination. 
start again, but I do need some help 
- who can I ask?. 

>Magic Wand Barrie TI1omas for advice and guidance. 
>Modify a few changes here. 
>New a new picture there 
>Dodge >Sharpen >Crop >Burn >Erase >Copy >Inverse >Cut >Move 
>Feather >Rotate >Paste >Save 
> Print I'm happy with that, are you happy with that? 
> Export to the RPS in Bath. 
> Zoom In my panel - here we go again. 
>Hide Options nowhere to hide - I'm so ne1vous 

- convinced I've failed. 
>Mode I think they like it? ...... ... YES, I've got it!!!! 

Save As John Gray ARPS 
john.grayedial.pipex.com 
(see the oolour pages) 

The Dlgltal Folio 

The Digital Disk Folio is still 
in existence thanks to Ray 
Grace who has kindly agreed 
torunit. 
He will be contacting exist­
ing members of the group 
and would be very pleased to 
hearfromotherswhowould 
like to participate. 

The contact details are: 

Ray Grace LRPS, 
8 Kirby Road, O>rsham, 
Wilts, SN13 9DS 

Home: 01249 716165 
Office:01225814082 
Fax: 01225814935 
email: grace@ndirect.co.uk 
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David Christie ARPS 

Tom Bowett FRPS 



1beDlgltallmaglngGroupc:oosis1sof membersofthe Royal.PhofograpbicSodetywbo baweelemd to pay an extra 
sub8crlpdoll 10~thegroup's joumalDIGD'andtoworktogetberviameetinpanddrculared pordoJios topromoee 
dlgbaJ tmaalnl Submissions rorlochasionlnDIGrrare-verywelcome. Please noce tbattheeditorwillwumetbat an 
persoossubmlltinamaterial baweeosuredtbattheyown the fullcopyrigbtof aDthelmagesand textsubmiam,and that 
aoylepllofrl..,ne,mwillbethe n:sponsJbffltyofthesub.Diart. CopyrlghtofaDthematerial publillbedisl'C8Cl'ftdlnaD 
c:ountrlesonbehalfoftheRPSandtheauehors. Anyviewsexpie'8Cd.venotoeciessarilytbo8eoftheRoyal.~ 
SodetyDOl"ofthe Di:giDI ImaglDIJC-.roup. Webaddress: http://www.diglt.org.uk 

1be ron ,rnlttee: 

CbaJrman: Mr Banie Thomas FBIPP FRPS 
ViceChairman: Dr Eddy Sethna FRPS 
Treasurer: Mr Geoffrey Carver LRPS 
Sea-etary: Mrs Glenys Taylor ARPS 
Editor DIGrr: Mr Bill Henley LRPS 
Beglooalc:oord1nator. Mr Bob Rowe ARPS 
Folio secretary: Mr Ray Grace LRPS &. f. 
Mr John Long ARPS 
Dr Barry Senior ARPS 

Digital Imaging Group 
Mr David Coombes ARPS 

To join the DIGIT emailing list just send an email to: 

requests@lists. wycliff ecollege.com 

with the message: 

subscribe digit 

Barrie lbomas FBIPP FRPS 
85 Beech Gardens 
Rainford 
WA118EB 

01744 883541 

banie@fotografx.demon.co.uk 

GlenysTaylor ARPS 
10 Shoreditch Road 

~~~~~~~~~~~~~~~~~~~~~ Tuoo~ 

Lecture by the 
Chairman of the 

Digital Imaging Group 

Barrie Thomas 
FRPS FBIPP MFIAP 

Viewing of the Digital 
Imaging Exhibition 

Saturday 3rd July 1999 
3pm 

in the Sunley Theatre 
The Octagon, Bath 

Tickets: £3.00 members 
£5.50 non members 

Available at the door 

Space may be-limited 

National 
Digital Imaging Day 

on Sunday 
10th October 1999 

at the Benn Hall in Rugby 

A one day event In this 
spacious venue with 

trade stands 
and demonstrations 

Somerset 
TA13BU 

01823 323986 (tel & fax) 
01823 282516 

106503,647@compuseive.com 

em Henley LRPS 
OldManse 
Middleyard 
King's Stanley 
Stonehouse 
Gloucestershire 
GL103QD 

01453825068 
A spectacular day which 

you must book in your weh@wycliffe.co.uk 

diary now! BobRowe ARPS 
2 Fleming Drive 

More details to follow. ~~ 
NG41FG 

Subscribe to the Listserver 
and 

Watch the web pages! 

0115 940 0733 

bob.rowe@btinlemet.com 
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